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tǊƛƴǘƛƴƎ ŀ ±ƛŜǿΦΦΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΦΧΧΧΦΧΧΦΦпл 

/ƘŀǊǘƛƴƎΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΦΧΧΧΧΧΧΧΧΧΦΧΧΧΧΧΦΦΦпп 

/ƘŀǊǘ ¢ƻƻƭǎΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦпр 



LOGIX PROFESSIONAL - USER GUIDE   

4  

      /ƘŀǊǘ ¢ŀōǳƭŀǘƛƻƴǎΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧ.ΧΦпс 

      /ƘŀǊǘ tǊƻǇŜǊǘƛŜǎΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧ..47 

9ȄǇƻǊǘƛƴƎΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΦΧΧΧΧΧΧΧΧΧΧΦΦΧΧΧΧΧΧ.ΧΦΦрн 

    .ŀǎƛŎ 9ȄǇƻǊǘΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΦΧΧΧΧΧΦΦΦΧΧΦΦΦΦрл 

9ƴƘŀƴŎŜŘ 9ȄǇƻǊǘ ²ƛȊŀǊŘΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΧΧΧΧΧΧΧΦΦро 

9ƴƘŀƴŎŜŘ 9ȄǇƻǊǘ ¢ŜƳǇƭŀǘŜǎΧΧΧΧΧΧΧΧΧΧΧΦΦΦΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΦΦΧΧрп 

               bŀƳŜŘ wŀƴƎŜǎΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΦΧΧΧΧрп 

               /ǊŜŀǘƛƴƎ 9ȄǇƻǊǘ ¢ŜƳǇƭŀǘŜΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΦΦΦΦΦрр 

       CƻǊƳŀǘǘƛƴƎ hǳǘǇǳǘǎΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΦсл 

       aǳƭǘƛǇƭŜ bŀƳŜŘ wŀƴƎŜǎΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦсн 

                9ƳōŜŘŘƛƴƎ /ƘŀǊǘǎ ŦǊƻƳ ±ƛŜǿǎΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΦсо 

                9ȄǇƻǊǘƛƴƎ DǊƻǳǇ {ǳƳƳŀǊƛŜǎΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧсп 

                Export Data as the Source for Charts and CalculationsΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦср 

                ±ƛŜǿ wǳƴƴŜǊΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦсс 

[ƻƎƛȄ ŀǎ ŀƴ h5!¢! tǊƻǾƛŘŜǊΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΧΧΧΧΦΦΦтл  

Using PowerPivot for Excel to Connect Logix ObjectsΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧтл 

Appendix A- ±ƛŜǿ aŜƴǳΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΦΦΧΧ.ΧΧΦΦΦтп 

Appendix B- /ƻƭǳƳƴ IŜŀŘŜǊΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΧΦΧΦΦтт 
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Introduction  

Logix Professional is a powerful drag-and-drop tool that allows you to ask complex questions of 

information drawn from different systems across an organisation. Logix Professional uses nothing 

more than simple drag-and-drop actions, easily building up powerful 'Views' which answer key 

business questions in an effective step-by-step fashion. Logix allows you to visualize and interact 

with your data in any way you like.  

  

Each View can then be filtered, grouped, sorted and charted in order to quickly visualise information 

and get all the insights needed for your organization. Again, you only need simple drag and drop 

actions in order to create powerful visualisations of otherwise complex information.  

  

Finally, you can share information in a fast and effective manner by publishing Views to colleagues, 

clients and suppliers with access to the Logix environment.   
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Accessing Logix  

As part of the Logix implementation you should have been provided with a shortcut to Logix on your 

desktop.   

  

If not, ask your Logix administrator for this shortcut and right-ŎƭƛŎƪ ƻƴ ȅƻǳǊ ŘŜǎƪǘƻǇΣ ǎŜƭŜŎǘ ΨbŜǿ Ҕ 

{ƘƻǊǘŎǳǘΩ ŀƴŘ ŜƴǘŜǊ ǘƘŜ ǇŀǘƘ ȅƻǳǊ ŀŘƳƛƴƛǎǘǊŀǘƻǊ Ƙŀǎ ƎƛǾŜƴ ȅƻǳ ǿƘƛŎƘ ǎƘƻǳƭŘ ōŜ ǎƛƳƛƭŀǊ ǘƻΥ   

  

\ \ some_server_name\ Logix Professional\ Logix.exe   

  

  
Logging in  
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Depending on how your Logix system has been configured, you will either log into Logix with your 

normal network username and password that you use to log into Windows or with a username and 

password that has been provided to you by your Logix administrator. The above image may appear 

slightly different to certain users, depending on what version of Logix Professional they have 

installed.   

  

  

  

  

  

  
 

 

 

Logging out  

  

  

  

Select the File Menu at the top left hand side of your screen. Then select  exit to logout of  

Logix.   

Before exiting Logix, do not forget to save your work. To do this you can select the File menu and 

select Save or  {ŀǾŜ !ǎΧΦ   

If you fail to save your work and decide to exit Logix, you will be prompted with an appropriate 

message like so.   
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The Logix Environment  

The main screen of Logix Professional  

   



LOGIX PROFESSIONAL - USER GUIDE   

9  

Menu Bar  

   File Menu    

       The File Menu allows the user to:   

  

‚ save their work,    

‚ cancel a particular action,    

‚ print a view,   

‚ delete a view,  

‚ restart Logix ,  

‚ exit out of Logix completely.   
  

   

  

    

View Menu  

 Here you can switch to and from a standard grid to a pivot grid .   

 You can also see your view as a Chart  and your Workspace .   

  

  

  

Within this menu if you select the group by  button, you will be able to drag a column  header 

into the area above the column headers. This will group your view by the selected column header.   

 You can also select the Find  button to do a search on a particular word.    
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If you would like to export your view you can hover over the Export option and select  your 

export of choice.   

Once again if you hover over the Refresh option at the bottom of the View Menu, you will be 

presented with two options:  Refresh Data  or  Refresh View .  
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 Modules Menu  
If you are viewing the backend of Logix and would like to return to see your views, you can 

quickly select f7 or select the  Modules  Menu and then the  Views 

option.   

You can also access the backend by pressing f8  or selecting the  Modules  Menu, 

hovering over the Admin option and selecting  Data Federation . ό{ŜŎǳǊƛǘȅΧΧΚΚΚΚύ  
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 Services Menu and Services List  
The Services List presents different areas of data within your organisation that have been made 

available for you to analyse. You can add more services to the Services list by clicking on the two 

arrows. An additional window will open which allows you to manage the number of services 

displayed in the services list in the main button bar. Only Services that the Logix Administrator has 

made available to you will be displayed in this list.  

Show Fewer Button ς will remove the last service listed in your services list.  

Show More Buttons - will add available services (not already listed) to your services list.  

Add or Remove Buttons ς will show you the complete list of services your administrator has made 

available to you and allow you to select services you wish to appear in the Services List.  

  

Ἑ You can also show all services available to you by clicking on 'Services ' on menu bar at  

the top. Click on the required service to open it.  

  

   Tools Menu  
 You can turn on and off column hints  here.  

  

  

   Help Menu  

User Guide -
 Logix Professional User Guide.   

Tutorial Videos- Nathean Technologies tutorial videos online.   

Web Client- Server Error.  

About- Click on the Help menu and  About to see the  licensing and version details  of your 

Logix installation. This information may be required by Nathean Technologies in a support situation.  
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Service Groups  

Service Groups are an easy way for the Logix Administrator to organise how the end user views each 

data service.  

The administrator creates the Service Group and adds the required Services to the Service Group. 

The end user can then open the views within the service. A service can be displayed in multiple 

groups.  

  

Views  

What is a view?  

Each area of analysis within the Services List is presented to the end user as a View. Views are saved 

representations of questions that have previously been asked of the data provided by a service. They 

hold the filtering, grouping, sorting and graphical  representation you see on the right hand side in 

the Workspace and iChart.  

  

These Views can be highly aggregated information such as Key Performance Indicators,  pre-

prepared metrics which have been prepared to provide a certain piece of information such as a 
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summarised look at the Employee Profile of your organisation or transaction level information such 

as Supplier Invoices or Customer Sales Orders.  

  

Views are dynamic  ōŜŎŀǳǎŜ ƛǘΩǎ ǘƘŜ ǉǳŜǎǘƛƻƴ ǘƘŀǘΩǎ ǎŀǾŜŘ ǊŀǘƘŜǊ ǘƘŀƴ ŀ Řŀǘŀ ǎŜǘΣ ŜǾŜǊȅ ǘƛƳŜ ȅƻǳ 

open a view, you get the current, up-to-date answer to that question!  

  

  

  

  

  
 

 

Views in Logix Professional  

 Each Logix Professional Service contains two discrete areas ς My Views and Shared   

 Views. Views can be moved between the two areas by dragging them with the mouse.   

When a View is in the My Views section it cannot be viewed by anyone other than the user currently 

logged in i.e. the owner of the View. This applies even if the View has previously been shared out to 

Users or Groups.  

  

Initial Views  

Logix is typically installed with a number of preconfigured Views created by your Logix Administrator 

during setup. These act as a convenient starting point for analysis.  

Views are listed in a tree view format, displayed to the left of the main screen. Selecting any View in 

the tree view causes Logix to display the information relating to that View on the right hand side of 

the screen.  
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View Folders  

Views can be organised into Folders within a Service. You can create Folders by right clicking the 

mouse and selecting the New Folder option from the popup menu on any of the following:  

‎ My Views  

‎ Shared Views  

‎ An Existing Folder  

Folders can be renamed by right-clicking and selecting Rename. Folders are ordered alphabetically 

within a Service.  

There is no limit on the number of levels of subfolders in a Service. Folders can be dragged into other 

folders or between My Views and Shared Views using the mouse. Folders can be published to 

selected Groups or Users.  

Folders can be deleted by right-clicking and selecting Delete. You will be asked to confirm if you are 

sure as this will delete all subfolders within the folder you have selected.   

Opening an Initial View  

To open an initial view,  

1. Browse to the data service you want to analyse by choosing the Service Group from the drop 

down menu.  

2. Click on the Service name in the Services List.  

3. Right-ŎƭƛŎƪ ƻƴ ǘƘŜ ǊŜǉǳƛǊŜŘ ǾƛŜǿ ŀƴŘ ŎƘƻƻǎŜ ΨhǇŜƴΩΦ ό!ƭǘŜǊƴŀǘƛǾŜƭȅ ȅƻǳ Ŏŀƴ ŘƻǳōƭŜ-click on 

the required view)   
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If a view requires additional variables (run-timŜ ǇŀǊŀƳŜǘŜǊǎύ ȅƻǳΩƭƭ ǎŜŜ ŀ ǇƻǇ-up box like the one 

below:  

  

  

ừ ²ƘŜƴ ȅƻǳ ŎƭƛŎƪ ƻƴ ǘƘŜ Ψ/ǳǊǊŜƴǘ ±ŀƭǳŜΩ ŦƛŜƭŘ ƻŦ ǎƻƳŜ ǇŀǊŀƳŜǘŜǊǎ ȅƻǳ Ƴŀȅ ǎŜŜ ǘƘŜ ǎƳŀƭƭ ōƻȄ 

ǿƛǘƘ ǘƘǊŜŜ Řƻǘǎ ŀǎ ƛƴ ǘƘŜ ΨtŜǊƛƻŘ wŀƴƎŜΩ ƘŜǊŜΦ  

ừ This indicates that a lookup exists for this parameter. Clicking on this button will launch in a 

new window. You can then select a value from the list that is presented to you.  

ừ /ƘŜŎƪƛƴƎ ǘƘŜ Ψ!ǇǇƭȅ ǘƻ ŀƭƭ ±ƛŜǿǎΩ ōƻȄ ǿƛƭƭ ŀǇǇƭȅ ǘƘŜǎŜ ǇŀǊŀƳŜǘŜǊǎ ǘƻ ŀƭƭ ǾƛŜǿǎ in the service 

for the duration of your Logix session.  

ừ Click OK and the view will load.  

ừ You can change the parameters for all views by clicking on the Show View  Parameters icon 

in the Logix toolbar shown below:   
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ừ The Logix view is dynamically updated when you change these parameters.  

  

Creating a New View  

The following steps will allow you to create a new View in a Service:  

1. Right-click on My Views, Shared Views or an existing Folder and select New View to open the 

New View wizard.  

2. 9ƴǘŜǊ ǘƘŜ ±ƛŜǿΩǎ bŀƳŜΣ ±ŜǊǎƛƻƴ ŀƴŘ ŀƴȅ bƻǘŜǎΦ ¸ƻǳ ǿƛƭƭ ōŜ ǊŜŎƻǊŘŜŘ ŀǎ ǘƘŜ ±ƛŜǿ hǿƴŜǊΦ  

3. Click on the Settings  button to set how the view will look when it loads. You can  

select Collapse  or  Expand all Groups on Load. Click  OK .  

4. Click Next to set the group permissions. This allows you to limit access to the  groups 

specified. If you do not specify permissions, only the view owner will have access.  
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5. To add Group permissions, click New . Highlight the required group from the list  displayed 

and click select (or double-click the Group name).  

6. The three levels of permission you can grant on a view are:  

‚ View: Allows the group to open your view or use it as the base to create 

new views.  

‚ Modify: Allows the group to save changes to your view. ‚ Delete: Allows 

the group to delete your view.  

7. Click Next to set the user level permissions in the same fashion. Users  permissions 

override Group permissions so you can grant a particular person privileges to modify your 

view while the rest of their team may have only view access (or no access at all).  

8. Click Finish to finish the wizard and create your view.   

The view created will look exactly like a spreadsheet. We can use the functionality in the next few 

chapters to turn this data into the answers to complex questions with simple drag and drop, point 

and click functionality.  

   

Deleting a View  

To delete a view, right click it and and select Delete . You must have permission to delete  that view.  
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Renaming a View  

To rename a view Select the view, right click and select Rename . You must have  

permission to modify the view.  

aŀǊƪƛƴƎ ŀ ±ƛŜǿ ŀǎ ŀ άCŀǾƻǳǊƛǘŜέ  

The Favourites service group acts as a shortcut for the user to access their regularly used views. 

Unlike the other Service Groups that the Logix Administrator sets up ς each user can manage their 

own Favourites service group.  

Select the view, right click and select Add to Favourites. When you next log into Logix, this view will 

ŀǇǇŜŀǊ ƛƴ ǘƘŜ CŀǾƻǳǊƛǘŜǎ ǎŜǊǾƛŎŜ ƎǊƻǳǇΦ ό!ƭǘŜǊƴŀǘƛǾŜƭȅ ȅƻǳ Ŏŀƴ ǊŜǎǘŀǊǘ [ƻƎƛȄ ōȅ ŎƭƛŎƪƛƴƎ ƻƴ άFile έ ƛƴ 

the top left hand corner of the toolbar and select  Restart and confirm  by clicking Ok  when 

prompted. This will allow you to see the new changes.)   

To remove a view from the Favourites Service Group, right click and select Remove from  

Favourites.  

  

Adding a View to a Dashboard  

Logix Web allows users to include views as components of any Dashboard they have write access to.  

If this functionality is enabled, you can add or remove a View to/from a Dashboard by right clicking 

on the view, choosing Dashboard and checking / unchecking the box beside the Dashboard you want 

to modify.  
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 (!ǎ 5ŀǎƘōƻŀǊŘǎ ŀǊŜ ŀ ŦŜŀǘǳǊŜ ƻŦ [ƻƎƛȄ ²ŜōΣ ǇƭŜŀǎŜ ŎƻƴǎǳƭǘΥ ά[ƻƎƛȄ ²Ŝō - ¦ǎŜǊ DǳƛŘŜέ ŦƻǊ ƳƻǊŜ )  

Edit Properties of a View  

Select the view, right click selects Properties. You can edit the Name, Display Name,  Version, and 

add in Notes from this screen. The  Created By field is automatically populated with the name of the 

user currently logged in.  

Navigating through Views  

You can move to previous views or navigate forward through views just viewed Using the Back and 

Forward Navigation button in the toolbar.  

Refresh a View  

You can reload the view by selecting the Refresh icon on the toolbar and selecting  

 Refresh Data or  Reload View. Alternatively, you can refresh the data by selecting F5.   

Altering Views  

Clicking on a column header will sort the view by the contents of that column, alternating between 

ascending and descending sort orders.  

  
Sort order of Columns  

To sort by more than one column, hold  

the shift key and click on subsequent column headers 

in the order you wish to sort them at. You will see a small triangle appear in the column 

header to indicate whether the sort order is ascending or descending andΣ ǿƘŜǊŜ ȅƻǳΩǾŜ 

sorted by more than one column, a number indicating the position that column holds in the 

sort ordering.  

  

Alternatively, right-click any column  

header to display the Header menu and  

ŎƘƻƻǎŜ Ψ{ƻǊǘ !ǎŎŜƴŘƛƴƎΩΣ Ψ{ƻǊǘ 5ŜǎŎŜƴŘƛƴƎΩ ƻǊ Ψ/ƭŜŀǊ {ƻǊǘƛƴƎΩΦ  
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Choosing Which Fields to Display  

You can remove or add fields to each View as required. To remove a field, right-click on any column 

ƘŜŀŘŜǊ ǘƻ ŘƛǎǇƭŀȅ ǘƘŜ IŜŀŘŜǊ aŜƴǳ ŀƴŘ ŎƘƻƻǎŜ ΨRemove This ColumnΩΦ   

To add or remove a field, right click on any column header to display the Header Menu and choose 

Field Chooser.   

The field chooser dialogue is displayed as below, listing fields which are not currently displayed. 

These may be fields you have chosen to remove previously, or fields that are not included in the 

current View by default.  

  

You can drag any of these fields from the field chooser onto the View header in order to display 

additional information or drag fields from the view header into the field chooser to remove 

unnecessary columns as required.  

For views where you are dealing wƛǘƘ ƭŀǊƎŜ ƴǳƳōŜǊǎ ƻŦ ŎƻƭǳƳƴǎΣ [ƻƎƛȄ ǇǊƻǾƛŘŜǎ ΨwŜƳƻǾŜ ŀƭƭ 

ŎƻƭǳƳƴǎΩ ŀƴŘ Ψ[ƻŎŀǘŜ /ƻƭǳƳƴΩ ŦǳƴŎǘƛƻƴǎΦ  

Clicking Remove all columns will prompt to ask are you sure and, on receiving a confirmation, 

remove all fields bar the leftmost column from the view.  

Locate Column allows you to search for a particular column in the field list.  
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Changing the Alignment of Information within Columns  

You can change the alignment of each column by right-clicking on any column header and hovering 

ƻǾŜǊ ΨAlignmentΩ ŀƴŘ ǘƘŜƴ ŎƘƻƻsing the option in which you would like the data to be displayed 

under the column header.   

  

Managing the Width of Columns  

Right-ŎƭƛŎƪ ƻƴ ŀƴȅ ŎƻƭǳƳƴ ƘŜŀŘŜǊ ŀƴŘ ŎƘƻƻǎŜ ΨBest FitΩ ǘƻ ǊŜǎƛȊŜ ǘƘŀǘ ŎƻƭǳƳƴ ǘƻ ōŜǎǘ Ŧƛǘ ƛǘǎ  contents.  

Alternatively, right-ŎƭƛŎƪ ƻƴ ŀƴȅ ŎƻƭǳƳƴ ƘŜŀŘŜǊ ǘƻ ŘƛǎǇƭŀȅ ǘƘŜ IŜŀŘŜǊ aŜƴǳ ŀƴŘ ŎƘƻƻǎŜ ΨBest Fit (all 
columns) Ω ǘƻ ǊŜǎƛȊŜ ŀƭƭ ŎƻƭǳƳƴǎ ǘƻ ōŜǎǘ Ŧƛǘ ǘƘŜƛǊ contents.    

Finally, you are free to drag the width of any columns to match personal requirements.  

Show Column Hints   

Hover the mouse over the column header and the details of the column such as column name, the 

service and the view you are viewing the column in. Column hints can be switched off by clicking on 

the Tools  menu on the toolbar and unticking Show Column Hints.  

Copying Data from a View  

Users have ability to copy data from the grid by selecting rows with Ctrl and  Shift.   

Ῐ Ctrl + click: select/deselect clicked row.  

Ῐ Shift + click: select rows from current row to clicked row.  

Ῐ Ctrl + C: copy selected rows to clipboard. Ῐ 

Click on any cell: deselect selected rows.  
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Filtering   

! ±ƛŜǿ Ŏŀƴ ōŜ ǘƘƻǳƎƘǘ ƻŦ ŀǎ ŀ ΨŘȅƴŀƳƛŎ ǎƭƛŎŜΩ ƻŦ ƛƴŦƻǊƳŀǘƛƻƴ ōŀǎŜŘ ƻƴ ǎƻƳŜ ŎǊƛǘŜǊƛŀ ƻŦ ƛƴǘŜǊŜǎǘ ǘƻ 

the user. This is just a starting point however, as you can extend a View to ask more complex 

business questions by using filters.   

Quick Filters  

Quick Filters can be applied to one or multiple columns to build up more complex questions. Clicking 

on the filter button to the right of any column header (arrow) shows the Quick Filter menu.  

  

ừ Ψ!ƭƭΩ will display all information in this  column, effectively 

removing any existing filter.  

  

ừ Ψ.ƭŀƴƪǎΩ will remove all rows with values in  this column.  

ừ Ψbƻƴ.ƭŀƴƪǎΩ will remove all rows with no  values in this 

column.  

  

ừ /ƘƻƻǎŜ Ψ/ǳǎǘƻƳΩ ǘƻ ŘƛǎǇƭŀȅ ǘƘŜ Custom Filter dialogue box.    

  
This dialogue enables you to limit the data displayed in the view using a simple two part  

AND/OR query, based on one or two mathematical operators e.g. (equals, is greater than, is less than 

etc.).  
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ừ Alternatively, you can create a filter by selecting the data values 

listed in the Quick Filter menu itself.  These values are taken from data 

contained in the field, and choosing a value in this way creates an 

ΨŜǉǳŀƭǎΩ ŎǊƛǘŜǊƛŀΦ    

  

ừ Multiple values can be selected by checking more than one box 
at a time.  

    

  

Advanced Filters  

!ǎ vǳƛŎƪ CƛƭǘŜǊǎ ŀǊŜ ŎǊŜŀǘŜŘΣ ǘƘŜ ŎǊƛǘŜǊƛŀ ǳǎŜŘ ŀǊŜ ŘƛǎǇƭŀȅŜŘ ƛƴ ǘƘŜ ΨCƛƭǘŜǊ .ŀǊΩ , a Blue (or  

dark grey depending on your Windows theme) box visible at the bottom of the View:  

  

You can add additional conditions in multiple AND, OR, NOT AND, NOT OR groups, using all the 

available logical operands (equals, does not equals, is less than, is less than or equal to, is greater 

than, is greater than or equal to, like, not like, is blank, is not blank, between, not between, in, not in) 

operating on any of the fields contained in the View.  

  

The Filter Builder dialogue box provides the following functions:  

OK: applies the current filter and closes the Filter Builder dialogue box  

 Cancel: cancels any changes to the current filter and closes the dialogue box   

Apply: applies the current filter to the View without closing the dialogue box, allowing you to 

interactively examine the results of the current conditions  
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Alternative Filters  

Two further methods exist for modifying filter criteria to adjust a View as required.   

Right-click anywhere on the View itself and the View Menu is displayed. Two options on the View 

Menu provide an easy way to extend the existing filter and modify the View accordingly.   

ừ Choose Ψ9ȄŎƭǳŘŜ ŦǊƻƳ ±ƛŜǿΩ  to modify the filter in order to exclude the selected  

record from the current View.   

ừ Choose Ψ9ȄŎƭǳŘŜ from ±ƛŜǿΩ , where equals the data displayed in the selected  

field, to exclude all rows containing the specific data in the chosen field from the current 

View.   

ừ In both cases, the result of these actions can be seen in the criteria displayed by the Filter Bar 

at the bottom of the View. See Appendix A for description of other functions in the View 

Menu. (((((?????))))))  

  

Using the Find Function to Build and Extend Views  

The Find function can be used to extend Views by easily creating more complex filters.   

    Choose ΨCƛƴŘΩ from the View  Menu and Logix will display the Find menu.     

    Enter a value to search for in the Ψ[ƻƻƪ ŦƻǊΩ text box.     
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Then choose the field to search in using the Ψ{ŜŀǊŎƘ ƛƴΩ  selector, which provides a  drop-

down menu of all fields in the current View.   

  

ừ Choose Ψ/ƻƴǘŀƛƴǎΩ  to find values similar to the search text in addition to precise  matches.   

ừ Choose Ψ.ŜƎƛƴǎ ²ƛǘƘΩ to find values which start with the search text.     

ừ Choose Ψ9ƴŘǎ ²ƛǘƘΩ  to find values which finish with the search text.     

ừ Choose Ψ9ȄŀŎǘ aŀǘŎƘΩ to find only values that precisely match the search text.   

ừ Choose Ψ!ƭƭ CƻƭŘŜǊǎΩ  to search across all Views.    

ừ Otherwise Logix will search the current View only.    

ừ Clicking the ΨCƛƴŘ bƻǿΩ button will carry out the search and the resulting criteria  will be 

displayed in the Filter Bar at the bottom of the View.  

  

The find function is cumulative; successive Find operations can act on the results of the previous 

Find operations if ά!ƭƭ CƻƭŘŜǊǎέ is left unchecked, enabling you to build up complex searches in a 

simple step-by-step fashion.  

 

Using Key Select to Find Data  

Logix enables you to search through any View quickly using a ΨƪŜȅ ǎŜƭŜŎǘΩ.  

Select any field in a View and start to type a value being sought- the View will jump to the first row 

where that value occurs, continuing to find the required match as more characters are typed.   

If you wish to find the first occurrence of a value across an entire View, ensure the View is sorted by the 

column in which you are searching.   
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Grouping  

To group data in the Workspace by any available column:  

῝ Right-click on a column header. Select ΨDǊƻǳǇ ōȅ ǘƘƛǎ ŦƛŜƭŘΩΦ  The data 

will now be grouped by the column you have chosen.   

῝ Select the ΨDǊƻǳǇ .ȅΩ  button in the Logix toolbar at the top of the  

screen. You could also right-click on the selected column header and switch 

on the Group By Box.  Once you have completed one of these  

two actions you can then drag a column header into the space allocated 

(above column headers).   

When you group by a column, the selected column then becomes eligible for charting, i.e. it 

becomes the charting entity. For example, if you have a workspace listing all employees in an 

organisation and you group them by department you can then chart any key statistic from the 

Workspace by department.   

There is no limit on the number of grouping levels that you can have in a Workspace however only 

the topmost grouping column may be charted (Note: Cross Tabulations rely on 2 levels of grouping). 

Once a View has been grouped, you can expand or contract individual groups by clicking on the plus 

or minus icon displayed to the left of the group title. Alternatively, right-click anywhere in the 

ŘŀǘŀƎǊƛŘ ǘƻ ŘƛǎǇƭŀȅ ǘƘŜ ǾƛŜǿ ƳŜƴǳ ŀƴŘ ŎƘƻƻǎŜ Ψ9ȄǇŀƴŘ ŀƭƭ DǊƻǳǇǎΩ ƻǊ Ψ/ƻƭƭŀǇǎŜ ŀƭƭ DǊƻǳǇǎΩΦ  

  

  

  

  

  

  

Ῐ Date / Time columns can be grouped by 

intervals like: Default (DateTime), Month and 

Year.  

Simply right click on the group header and 

choose the Grouping Interval you wish to use.  
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Using Footers and Group Footers  

You can summarise the data in your views by right-clicking on the column header to display the 

IŜŀŘŜǊ aŜƴǳ ŀƴŘ ŎƘƻƻǎƛƴƎ ΨCƻƻǘŜǊΩΦ ! ƎǊŜȅ κ ǿƘƛǘŜ όŘŜǇŜƴŘƛƴƎ ƻƴ ȅƻǳǊ ²ƛƴŘƻǿǎ ¢ƘŜƳŜύ ŦƻƻǘŜǊ 

area at the bottom of the View is made visible.   

Right-click the View footer underneath the column(s) of data you wish to summarise and choose one 

from the statistical options provided: Sum, Min, Max, Count or Average.   

  

Additionally, if your view has groupings, you can 

use Group Footers to analyse the contents of each 

group and sub-group in the same way: simply 

right-click on any column header to display the 

IŜŀŘŜǊ aŜƴǳ ŀƴŘ ŎƘƻƻǎŜ ΨDǊƻǳǇ CƻƻǘŜǊǎΩΦ   

A footer area for each group is made visible. Right-

click anywhere in the group footer and choose from      

the options provided.   

  

The statistics created by any group footers will be available to modify in the Group Summary Details 

dialog.   

Group Summary Details  

The key statistics for any Logix Professional View are managed using a feature called Group 

Summary Details. This feature allows you to create dynamic summary information based on any 

column in the view.   

The summary is then displayed either in Group Headers or Group Footers. Group Summary Details 

becomes available when you have grouped by at least one column.  

The Group Summary Details also determines the Charting Data. When you group by a column, the 

selected column then becomes eligible for charting. Once you have chosen the data from the view 

that you wish to chart by, any subsequent change that you make to the Workspace (filtering, sorting, 

grouping, etc.) is immediately reflected in the attached chart.   
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¢ƻ ƳŀƴŀƎŜ ŀ ±ƛŜǿΩǎ DǊƻǳǇ {ǳƳƳŀǊȅ 5ŜǘŀƛƭǎΣ ǊƛƎƘǘ-click any whitespace in the workspace and select 

ΨDǊƻǳǇ {ǳƳƳŀǊȅ 5ŜǘŀƛƭǎΩΦ  

  

  

  

Each Group Summary has the following properties:  

  

Column  The column from the Workspace that the summary will operate on.  

Type  The operation to perform on the data. The available options are: Average, Count, Count 

Distinct, Max, Min, Sum.  

Format  Specifies the formatting string to display a summary value.  

Display  Determines the summary information is displayed. The 2 options are In Group Headers or 

In Group Footers.  

Sort Groups by this 

Summary Detail  

If this box is checked the groups in the view will be sorted by the summary values as 

opposed to the default numeric / alphabetic sorting.   

  

  

Once a group header summary has been 

created, you can quickly choose whether to sort by any of 

the Summary Details or by the Group Value by right 

clicking on any of the values presented in the group  

header.   
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Number Formatting in Group Summaries:  

  

 

 

 

 

 

 

 

 

 

 

 

 
 

 

(*) 

¶ Reserved characters need to be enclosed in single quote marks.  For example, if you wish to show a count 

of an Age Band in the following format - Ψл нм-олΩ ǳǎŜ ǘƘŜ ŦƻƭƭƻǿƛƴƎ ǎǘǊƛƴƎ - лΣ Ωнм-олΩΦ 

 

¶ When formatting numeric values, the letter E is a reserved for scientific notation.  Therefore, enclose any 

labels which contaiƴ 9 ǿƛǘƘƛƴ ǉǳƻǘŜǎΣ ŦƻǊ ŜȄŀƳǇƭŜΣ ϵлΣ Ψ¢ƻǘŀƭ {ŀƭŜǎΩ ǊŀǘƘŜǊ ǘƘŀƴ ϵлΣ ¢ƻǘŀƭ {ŀƭŜǎΦ 

(*) 

 

Operations Between Group Summaries  

Logix allows the user to create Group Summary Details which are the result of an operation between 

already created summaries. An example would be expressing one summary as a percentage of 

another.   

This is accomplished using the Group Summary Dialog as follows:   

0  Displays unformatted numbers   

0,  Displays numbers with comma-separated thousands e.g. 1000 -> 1,000   

£0  Displays numbers preceded with the currency symbol specified   

0.00  Displays numbers to two levels of decimal place  

0.000  Displays numbers to three levels of decimal place (add zeros for more places)  

0.000E+00 (*) Displays using scientific notation (*) 

Val: £0,.00  ²ƻǳƭŘ ŎƻƳōƛƴŜ ŀƭƭ ǘƘŜ ŀōƻǾŜ ǘƻ ǎƘƻǿ мллл ŀǎ Ψ±ŀƭΥ ϻмΣлллΦллΩ ƛƴ DǊƻǳǇ IŜŀŘŜǊǎ  

0.00;(0.00) Display numbers to two decimal places, showing negative values in brackets  
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Column  Select any numeric column  

Type   Group Formula  

Format  Specify the summaries to use and the operation to perform. An example is:  
  

                          $$(G1%G2):0.00%  

  

This breaks down as follows:  

  

$$ - Alerts Logix that the summary is an operation between other summaries.   
  

(G1%G2) - Specifies which summaries to use (where the number represents 
the Group Summary Position) and the operation to perform. The available 
operands to perform. The available operands are:  
  

+  Addition  

-  Subtraction  

*  Multiplication  

/  Division  

%  Percentage  

:-  Separates summary calculation from 

formatting string  
 

Display  Must be set to Group Headers  

Sort Groups by this 

Summary Detail  

If this box is checked the groups in the view will be sorted by the calculated 

summary value  
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Calculated Fields  

A calculated field is a column in a dataset that is derived from the values of others columns (e.g. 

Column 1 ς Column 2).  

Adding a calculated field to a view:  

Ἑ Right click a column heading.  Ἑ 

{ŜƭŜŎǘ Ψ!ŘŘ /ŀƭŎǳƭŀǘŜŘ CƛŜƭŘǎΩΦ  

  

You will then be presented with the following calculated field dialog:   

  

The following sections exist on the Calculated Field dialog:  
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Variables  

The variables list will display a list of appropriate variables for the selected operation type (e.g. Date 

operation will only display Date fields). Double clicking on any variable will cause that variable to be 

inserted into the formula area at the bottom of the window.  Operations  

The operations section consists of different types of operations that you may wish to perform 

(Numeric, Date etc). Selecting a value from this list will populate the list directly below with a list of 

available functions for that type of operation. For numeric (+, -, / etc), for Dates (AddMonths, 

AddYears, etc.).  

Double clicking on any function will cause the function to be inserted into the formula area at the 

bottom of the window.   

A calculated field must have a display label entered. The text area at the bottom will contain the 

actual formula to be used.   

You can also select a Display Format and Alignment.  

  

Evaluation  

The evaluation section provides the ability to test the formula entered, each variable used in the 

formula will appear above the evaluate button. Test values can be entered for these variables. 

Pressing the evaluate function will evaluate the expression with the test values entered.  

   

  

Date Operations in Calculated Fields   

Only deployments of Logix using Parser Engine V2 (refer to Logix Admin Guide) will be able to use 

dates in calculated fields. The following date functions are available:   

ừ AddMonths   

ừ AddYears   
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ừ AddDays   

To add a number of months to a date the following syntax is used:   

ừ [myDateField].AddMonths(5)   

Likewise, to subtract a number of months:   

ừ [myDateField].AddMonths(-5)   

Note: Calculated fields will be added the object definition in Logix and will be available to all views 

derived from that object.  

  

Pivot grids  

An alternative way of analysing your data with Logix Professional is to create a Pivot Grid summary of 

the data held in your view.   

  

/ƭƛŎƪ ƻƴ ǘƘŜ Ψ{ǿƛǘŎƘ ǘƻ {ǘŀƴŘŀǊŘ κ tƛǾƻǘ  

DǊƛŘΩ ƛŎƻƴ ƻƴ ǘƘŜ ǘŀǎƪōŀǊ ǘƻ ƻǇŜƴ ǘƘŜ tƛǾƻǘDǊƛŘ 

mode. Any filtering you have already defined in 

the standard  

  

Workspace before the PivotGrid view is enabled will be brought through as a  

ΨtǊŜŦƛƭǘŜǊΩΦ   

  LŦ ǘƘŜ ŦƛŜƭŘ ƭƛǎǘ ŘƻŜǎƴΩǘ ŀǇǇŜŀǊ ȅƻǳ Ŏŀƴ ŘƛǎǇƭŀȅ ƛt by clicking on the icon displayed to the right of the 

Go button or you can right-click in the pivot header ŦƛŜƭŘ ŀƴŘ ŎƘƻƻǎŜ ά{Ƙƻǿ CƛŜƭŘ [ƛǎǘέΦ  

  


